DEVELOPMENT OF AN INTERACTIVE AUGMENTED REALITY-BASED APPLICATION FOR TEACHING PEDIATRIC CAUDAL EPIDURAL BLOCKADES

by
Caitlin Mock

A thesis submitted to Johns Hopkins University in conformity with the requirements for the degree of Master of Arts

Baltimore, Maryland
March, 2016

© 2016 Caitlin Mock
All Rights Reserved
ABSTRACT

A caudal epidural blockade (CEB) is a procedure involving administration of an anesthetic into the caudal epidural space of the vertebral column to provide analgesia for pediatric patients undergoing lower abdominal or lower limb surgery. The injection occurs at the sacral hiatus, a gap in the distal sacrum at the termination of the spinal canal that is covered by the sacrococcygeal ligament, subcutaneous fat, and skin. To perform the procedure successfully, anesthesiologists must accurately identify the sacral hiatus and bordering sacral cornua without visual guidance. A firm understanding of the pediatric sacral anatomy is critical in performing the procedure safely and effectively, but few resources exist to address the three-dimensional relationships of the surface and underlying anatomy.

An interactive tablet-based application was designed and developed to allow clinicians-in-training for the CEB procedure to correlate surface landmarks of the pediatric sacrum with internal structures and to depict proper CEB technique, including needle placement. CT and MRI datasets, in combination with a review of anatomical literature, were employed as reference material to create a novel 3D model of the pediatric sacrum, pelvis, sacrococcygeal ligament, and the distal dural sac and internal vertebral venous plexus. The application displays the 3D model through an interactive interface and via augmented reality software, allowing users to visualize the anatomical relationships, size, and scale of the pediatric sacrum in real-time. End users provided input on the design and content of the application at each stage.

This project contributes to the anatomical and educational resources available to pediatric anesthesiology residents, fellows, and certified registered nurse anesthetists and lays the foundation for development of additional applications for techniques in pediatric regional anesthesia.

Caitlin Mock
Chairpersons of the Supervisory Committee

Lydia Gregg, MA, CMI, FAMI, Department Advisor
Assistant Professor, Division of Interventional Neuroradiology and Department of Art as Applied to Medicine, Johns Hopkins University, School of Medicine

Robert S. Greenberg, MD, Preceptor
Associate Professor of Anesthesiology and Critical Care Medicine, Johns Hopkins University School of Medicine

Deepa Kattail, MD, Content Advisor
Assistant Professor of Anesthesiology and Critical Care Medicine, Johns Hopkins University School of Medicine
ACKNOWLEDGEMENTS

This project would not have been possible without the knowledge, guidance, and support of so many wonderful individuals.

Lydia Gregg, MA, CMI, FAMI, Assistant Professor, Division of Interventional Neuroradiology and Department of Art as Applied to Medicine, Johns Hopkins University, School of Medicine, and thesis advisor. I am fortunate to have worked under the guidance of such an outstanding and knowledgeable mentor. Her steady encouragement, patience, and unparalleled creative and technical advice were essential to the success of this project.

Robert S. Greenberg, MD, Associate Professor of Anesthesiology and Critical Care Medicine, Johns Hopkins University School of Medicine, and thesis preceptor to whom I am grateful for the opportunity to collaborate with on his initial project proposal and make it my own. His enthusiasm and instruction throughout the project were vital to its fruition.

Deepa Kattail, MD, Assistant Professor of Anesthesiology and Critical Care Medicine, Johns Hopkins University School of Medicine, and content advisor. I am thankful for her contribution of time, knowledge, and feedback to each step of the project.

Bommy Mershon, MD, Assistant Director of Patient Safety and Clinical Quality, Department of Anesthesiology and Critical Care Medicine, Johns Hopkins Hospital, and the fellows, residents, and CRNAs in pediatric anesthesiology who gave their time and feedback to contribute to the content planning of the thesis.

Russel Adams, iSO-FORM, Director of Technology, for his remote support in the use and design of Unity3D files.

Dacia Balch, Academic Program Administrator, Department of Art as Applied to Medicine, Johns Hopkins School of Medicine, thank you for knowing the answers to all of my questions and genuinely caring for each and every one of us.
A huge thanks is due to the faculty in the Department of Art as Applied to Medicine, Corinne Sandone, MA, CMI, FAMI, Gary Lees, MS, CMI, FAMI, Timothy Phelps, MS, FAMI, David Rini, MFA, CMI, FAMI, and Jennifer Fairman, MA, CMI, FAMI, and Juan Garcia, CCA, for being amazing teachers and mentors, contributing vastly to my growth as a biomedical illustrator.

To my classmates, Erica Chin, Emily Ling, Kari Opert, Laura Roy, Kai-ou Tang, and Amy Zhong, I can not thank them enough for their fierce friendship and unwavering encouragement, day in and day out.

Thank you to my family, my parents, Chris and Debbie Mock, and my siblings, Cody Mock, Morgan Schmidt, and Liam Mock, and my grandmas Jeanne Hepker and Carolyn Mock for being a constant source of love, laughs, and prayers, and always reminding me of the bigger picture.
# Table of Contents

Abstract...............................................................................................................................ii
Acknowledgements............................................................................................................iv
Table of Contents ...............................................................................................................vi
List of Tables ....................................................................................................................viii
List of Figures ....................................................................................................................ix
Introduction .........................................................................................................................1
  CEB Landmarks and Procedure.........................................................................................2
  Pediatric versus Adult Anatomy.......................................................................................3
  Augmented Reality in Medical Education .........................................................................5
Objectives ..........................................................................................................................7
Audience .............................................................................................................................7
Materials and Methods ......................................................................................................8
  Software ..........................................................................................................................8
  Application Design and Development ..........................................................................8
  Three-Dimensional Asset Creation ..............................................................................10
Creating Textures in Cinema4D ....................................................................................21
Animating in Cinema4D ....................................................................................................23
Creation of Prototype Animatic in Adobe After Effects ..................................................25
Creating Interactive Application and AR in Unity3D .....................................................27
3D Print ............................................................................................................................30
Results ...............................................................................................................................32
  Educational Content Goals ..........................................................................................32
  Review of Literature .....................................................................................................32
  Flowchart and Storyboards .........................................................................................33
  Three-Dimensional Model ..........................................................................................41
Didactic Procedural Animations ......................................................................................53
Prototype Animatic ..........................................................................................................53
Interactive Application ....................................................................................................54
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sketchfab Model Viewer</td>
<td>54</td>
</tr>
<tr>
<td>3D Print</td>
<td>54</td>
</tr>
<tr>
<td>Access to Assets</td>
<td>65</td>
</tr>
<tr>
<td>Discussion</td>
<td>66</td>
</tr>
<tr>
<td>Developing a Solution to Reduce the CEB Learning Curve</td>
<td>66</td>
</tr>
<tr>
<td>Assigning Media Styles</td>
<td>67</td>
</tr>
<tr>
<td>Addressing Three-Dimensional Relationships and Tactile Feedback</td>
<td>68</td>
</tr>
<tr>
<td>Anatomical Reference Material</td>
<td>69</td>
</tr>
<tr>
<td>Modeling</td>
<td>70</td>
</tr>
<tr>
<td>Prototype Design</td>
<td>71</td>
</tr>
<tr>
<td>Further Development of Augmented Reality</td>
<td>72</td>
</tr>
<tr>
<td>Future Application Development</td>
<td>73</td>
</tr>
<tr>
<td>Conclusion</td>
<td>74</td>
</tr>
<tr>
<td>Appendix A</td>
<td>75</td>
</tr>
<tr>
<td>Appendix B</td>
<td>77</td>
</tr>
<tr>
<td>Cited References</td>
<td>78</td>
</tr>
<tr>
<td>General References</td>
<td>81</td>
</tr>
<tr>
<td>Vita</td>
<td>82</td>
</tr>
</tbody>
</table>
LIST OF TABLES

Table 1. Pediatric and adult comparative sacral anatomy ................................................33
LIST OF FIGURES

Figure 1. CEB injection ........................................................................................................ 2
Figure 2. Comparative anatomy of the sagittal sacrum ...................................................... 3
Figure 3. Comparative anatomy of the sacrum ................................................................. 4
Figure 4. Augmented reality .............................................................................................. 6
Figure 5. 3D volume rendering ...................................................................................... 11
Figure 6. Surface export settings ................................................................................... 11
Figure 7. Importing reference images ............................................................................ 12
Figure 8. Retopologizing with ZRemesher ..................................................................... 14
Figure 9. Aligned models ............................................................................................... 15
Figure 10. Generating IVVP with splines ....................................................................... 17
Figure 11. Dural sac export ......................................................................................... 19
Figure 12. Sacroccygeal ligament model ........................................................................ 20
Figure 13. Polycount reduction with Decimation Master ................................................ 22
Figure 14. CEB procedure animation ........................................................................ 24
Figure 15. Cinema4D FBX export settings ..................................................................... 28
Figure 16. CEB model in Unity scene ........................................................................ 28
Figure 17. Script objects defined .................................................................................. 29
Figure 18. Bool operation assigned ............................................................................... 30
Figure 19. 3D print, create shell ................................................................................... 31
Figure 20. Flowchart ...................................................................................................... 34
Figure 21.1-12. Storyboards ........................................................................................ 35
Figure 22.1-2. Reference illustrations .......................................................................... 42
Figure 23. Full model, posterior .................................................................................. 44
Figure 24. Full model, anterior .................................................................................... 45
Figure 25. Sacrum model ............................................................................................. 46
Figure 26. Lateral models ............................................................................................. 47
Figure 27. Dural sac and IVVP ................................................................................... 48
Figure 28. IVVP .......................................................................................................... 49
INTRODUCTION

Regional anesthesia is a technique for administering anesthetics near the spinal cord or a specific cluster of nerves in order to affect a limited area of the body that requires analgesia or pain relief. The effects of a regional anesthetic last for a longer period of time than other techniques (e.g. general anesthesia, sedation), providing the patient with increased pain relief intra- and post-operatively (Lees et al. 2014).

One form of regional anesthesia is an epidural blockade (block), the injection of an anesthetic into the epidural space of the spinal canal. In a caudal epidural blockade (CEB), the epidural space is accessed through the sacral hiatus, a gap in the distal sacrum where the fifth sacral laminae remain unfused at the midline (Edler and Wellis 1998).

CEBs are one of the most common regional anesthetic techniques used in pediatric surgery, providing analgesia for pediatric patients undergoing surgery involving the lower abdomen and legs (Lees et al. 2014; Tsui and Berde 2005). The procedure is ideal for children because they have less subcutaneous presacral fat allowing for easier palpation of boney landmarks. Also, the sacrococcygeal ligament is not yet calcified and easier to puncture (Suresh and Wheeler 2002). Compared to lumbar or thoracic epidurals, there is a lower risk of spinal cord injury (Edler and Wellis 1998).

Improper needle insertion can result in a failed block or inadequate pain control, dural puncture, epidural hematoma, and neurological injury (Lees et al. 2014). Performing this block on pediatric patients has the added challenge of minimal to no feedback from the patient as they are often heavily sedated, anesthetized, or are unable to verbally communicate the effects of the block (Buckenmaier III and Bleckner 2008).
**CEB Landmarks and Procedure**

The procedure begins with identification of the paired sacral cornua, which lie about 0.5-1 cm apart (Buckenmaier III and Bleckner 2008; Suresh and Wheeler 2002) and represent the remains of the unfused fifth sacral laminae. The sacral hiatus lies between these two cornu at the S4-S5 level (Fig. 1), and is covered by the sacrococcygeal ligament, subcutaneous fat, and skin (Shin et al. 2009).

To perform a “single shot” CEB, a 22 G needle is attached to a 10 ml syringe and inserted through the skin and fat at a 45-degree angle to the skin. When the needle meets the sacrococcygeal ligament, there is a slight increase in resistance until a “pop” is felt, indicating that the needle has pierced the ligament. While maintaining the position of the needle tip in the epidural space, the angle of the syringe is reduced until it is nearly parallel with the skin as well as the spinal canal (Buckenmaier III and Bleckner 2008). The needle is then advanced 2-4 mm into the epidural space.

**Figure 1. CEB injection.** A “single shot” CEB is administered through the sacrococcygeal ligament into the caudal epidural space.
and aspirated for blood or cerebrospinal fluid (Buckenmaier III and Bleckner 2008) (Fig. 1). If negative, a “test dose” is delivered which should not be met with injection resistance, and should not result in clinical changes (increased heart rate or electrocardiogram changes) indicating, for example, inadvertent intravascular injection (Tsui and Berde 2005). Finally, the entire dose is injected into the epidural space. The skin over the sacrum is palpated to check for a subcutaneous injection.

**Pediatric versus Adult Anatomy**

The pediatric sacrum, when compared to that of an adult, is not only smaller and largely unossified, but the relative scale of the caudal epidural space differs substantially (Soliman, Ansara, and Laberge 1978). The conus medullaris is located more caudally in pediatric patients, between spinal levels L2 and L3, compared to

![Figure 2. Comparative anatomy of the sagittal sacrum.](image)

**Figure 2. Comparative anatomy of the sagittal sacrum.** Comparison of AP depth and dural sac termination in the (A) pediatric and (B) adult sacrum. Measurements derived from a single reference (Lees et al. 2014). For comprehensive measurement list from the literature review, see Table 1.
levels L1 and L2 in adults (Lees et al. 2014). The lower limit of the dural sac in children less than a year old generally terminates between levels S3-S4 (NYSORA 2008) and gradually ascends cephalad to end approximately at level S2 in adults (Senoglu et al. 2005) (Fig. 2).

In children, the sacral hiatus is about 9 ± 3 mm wide compared to 17 ± 3 mm in adults (Lees et al. 2014) (Fig. 3). The distance from the sacral hiatus to the termination of the dural sac ranges from 13-57 mm in children, and the anterior-posterior depth of the spinal canal at the sacral hiatus is 3.9 ± 1.3 mm (Lees et al. 2014).

Understanding the anatomy of the caudal space is critical to the safe, effective performance of the CEB. Although ultrasound imaging has improved anatomical

Figure 3. Comparative anatomy of the sacrum. Pediatric sacrum, (A) anterior and (B) posterior, compared to a posterior view of an adult (C). Measurements derived from a single reference (Lees et al. 2014). For comprehensive measurement list from the literature review, see Table 1.
visualization during CEB, the procedure is known for its steep learning curve (Lees et al. 2014). Anesthesiologists must rely on their anatomical knowledge to accurately perform the procedure (Lees et al. 2014). Available educational resources depict the procedure with limited 2D images or diagrams. Additionally, most resources use adult (rather than pediatric) models to convey the anatomy. According to Suresh and Wheeler (2002), “The sacrum is the most variable bone in the body…” highlighting the necessity for detailed appreciation of the anatomy and key relationships before performing the procedure.

**Augmented Reality in Medical Education**

Augmented reality (AR) is a technology that integrates virtual elements with the user’s immediate surroundings so that they can then interact with computer-generated data in real time (Monkman and Kushniruk 2015). This technology has been implemented in medical education in a variety of ways such as teaching anatomy, visualizing ultrasounds and CT scans, and enhancing anatomical landmarks in laparoscopic procedures (Monkman and Kushniruk 2015). Allowing users to interact with 3D models from different points of view, including through AR, can improve their spatial awareness, memory of the subject, and enable personalized, self-directed learning (Küçük, Kapakin, and Göktaş 2016).

The novel integration of augmented reality in teaching pediatric sacral morphology will fill a gap in educational resources for CEB. Users will be able to visualize and interact with 3D models of the anatomy in “real-time,” where the models respond immediately to user input, and develop an appreciation for the major procedure landmarks and size of the pediatric sacrum (see Fig. 4). This project lays the foundation for the development of more applications in pediatric medicine, and ultimately aims to reduce the learning curve for CEB.
Figure 4. Augmented reality. Early proof of concept image depicting the pediatric sacrum and 10 ml syringe in the augmented reality-based portion of the application.
Objectives

The purpose of this thesis was to create a tablet-based (Apple iPad platform) application that aims to reduce the learning curve for performing pediatric caudal epidural nerve blocks through the following objectives.

1. Design a user interface based on consultant feedback acquired during a needs assessment and at the prototype phase from anesthesiology clinicians.
2. Use CT and MRI data in combination with a review of anatomical literature to create an accurate 3D model of a pediatric sacrum, pelvis, sacrococcygeal ligament, and the distal sacral portion of the dural sac and internal vertebral venous plexus.
3. Develop an interface that will allow the user to interact with these 3D models in “real-time” to visualize and communicate the anatomical relationships of the pediatric sacrum.
4. Develop an augmented reality viewing mode for the same 3D models to enforce the size relationships and scales of the pediatric anatomy.
5. Create a real-time animation to depict proper CEB technique, including needle placement, as well as procedure indications, dosing, and ultrasound imaging.

Audience

The primary audience of this interactive application is pediatric anesthesiology residents, fellows, and certified registered nurse anesthetists who are expected to learn and perform this procedure on a day-to-day basis.
MATERIALS AND METHODS

Software

To create the assets and final products of this project, a range of software was utilized. Many of the programs have overlapping functions and were used in combination to achieve the desired results efficiently. OsiriX® was used to extract 3D pediatric sacrum models from CT and MRI datasets. ZBrush®, Cinema4D®, and Adobe Photoshop® were used in conjunction to model and texture the 3D models. Cinema4D, Adobe After Effects®, and Adobe Illustrator® were used to compile and animate the procedure and the application prototype. Unity3D® game engine was used to create the 3D interactive interface, while Qualcomm® Vuforia extension for Unity was employed to create the augmented reality portion of the application.

Application Design and Development

Content Aggregation and Synthesis

Information from various resources including research, interviews, and clinical observation, was gathered to determine the educational content of the interactive application. A review of educational literature regarding the pediatric CEB was performed to ascertain what visuals and resources were currently available for teaching purposes and to understand the procedure and relevant anatomy. The content of the project was further informed through conversations with two attending physicians, four residents and two fellows in pediatric anesthesiology, and two certified registered nurse anesthetists. These physicians described what made the CEB a particularly difficult procedure to learn and aided in directing the scope of the project. A series of questions (Appendix A) was utilized to guide conversations with clinical consultants. Additionally, the CEB procedure was observed in person at the Johns Hopkins Hospital in order to gain a full understanding of the spatial
relationships involved in needle insertion. Specific educational goals were defined and prioritized based on these observations and conversations.

*Flowchart and Storyboard Production*

An outline of CEB-related educational topics to be included in the application was created based on the aggregated educational content. Topics were then divided into navigable page content with a main menu and subtopics. The main menu includes pages that, when navigated in order, guide the user through the major points of the procedure from initial indications to complications. The subtopics and didactic visual elements were defined and categorized under the main topics and arranged into a conceptual flowchart in order to establish the navigational structure of the application. This flowchart was then modified based on feedback regarding the priority of each topic in medical education from two attending pediatric anesthesiologists (thesis preceptor, Robert S. Greenberg, MD and content advisor, Deepa Kattail, MD).

A specific visual media choice was then determined based on the nature of the content in each educational topic of the flowchart. These decisions were indicated with color-coding on the flowchart.

After the entire application was described in the flowchart, educational sections were chosen for further development within the scope of this project. A series of storyboards were then created for these chosen sections to plan the design and layout of the application and its components. Rough sketches were integrated into a vector-based layout in Adobe Illustrator. The storyboards were then reviewed by the same two attending pediatric anesthesiologists and revised accordingly. The final layout of the application in both the prototype animation as well as the Unity3D application was based on these storyboards.
Three-Dimensional Asset Creation

Extraction of Models from DICOM Datasets

Anonymized pediatric and adult CT and MRI datasets were obtained from Johns Hopkins Hospital in accordance with HIPAA (Health Insurance Portability and Accountability Act of 1996) standards to use as reference material in creating the 3D models of an adult sacrum and pelvis, and a pediatric sacrum, pelvis, skin, and dural sac.

The DICOM datasets were imported into OsiriX DICOM imaging software to extract models. In the OsiriX default database window, a dataset was selected and opened in a new window and then converted into a 3D volume rendering, 2D/3D > 3D Volume Rendering, and set to 16-bit mode. Using the histogram density graph, the bone of the model was isolated, and the density value noted for future use in 3D surface rendering (Fig. 5). Anatomy in the region of interest was isolated using the Scissor Tool. The model was then converted to a 3D surface rendering, 2D/3D > 3D Surface Rendering. Optimal surface rendering, now selective to the region of interest, minimized the amount of holes in the surface mesh, and was generated by adjusting “Pixel Value” and Resolution settings. The value of the region of interest previously noted in the histogram density graph was used as a starting point for the “Pixel Value” setting. The Resolution was set to high, Decimate- Resolution set to 5.0-1.00 and Smooth-Iterations set to between 50-100 (Fig. 6). These values varied per model and were determined after multiple 3D surface renderings attempts. The model was then exported as an OBJ (Export 3D-SR > Export as Wavefront (.obj)).

Reference Drawings for Model Creation

Using the pediatric CT and MRI datasets, measurements were taken of the sacrum and dural sac in OsiriX using the Measure Length tool. These measurements were used to determine the initial proportions of the sacrum and dural sac, width of sacral
Figure 5. **3D volume rendering.** Volume rendering generated and histogram used to isolate bone density.

Figure 6. **Surface export settings.** Decimate-Resolutions, Smooth-Iterations, and Pixel value settings adjusted for best surface render.
hiatus, distance between sacral cornua, and anterior-posterior depth of sacral hiatus.

Average values determined through the literature review were found for the following measurements: width of sacral hiatus, distance between sacral cornua, anterior-posterior depth of sacral hiatus, distance from sacral hiatus to dural sac, and point of dural sac termination. These data were used to create a series of illustrations for both the sagittal and posterior views of the sacrum and dural sac based off the initial 3D model exports. The illustrations were scanned and imported into ZBrush where they were projected on a grid and used as reference images for use in sculpting and refining the 3D models into average 3-month-old pediatric anatomy.

In the main ZBrush window, the **Texture** palette was opened and **Import** selected. The desired posterior and sagittal illustrations were then chosen and loaded into the ZBrush file. To apply the images to the grid, the **Draw** palette was accessed and the **Floor** button turned “on”. In the same palette, the **Front-Back** menu was opened, the **Map1** icon selected, and the posterior illustration chosen (**Fig. 7**). The same is then repeated for the **Left-Right** menu, loading the sagittal illustration into **Map1**. The image sizes and positions of the projected grid were adjusted to match the size of the pediatric model from the CT scan.

![Figure 7. Importing reference images. Reference image loaded into Zbrush Draw palette.](image-url)
Model Creation in ZBrush and Cinema4D

Sacrum, Pelvis, Skin

Selecting Tool > Import in the Tool palette imported the pediatric sacrum OBJ file into ZBrush. In order to view both sides of the polygons, double sided view was enabled (Tool > Display Properties > Double). The pediatric sacrum subtool was then duplicated and the adult sacrum was imported (Tool > Import), its shape replacing that of the pediatric sacrum in the subtool. This process was repeated for the adult pelvis and the pediatric pelvis, dural sac, and skin.

The OBJ files and resulting 3D models underwent selective deletion of floating polygons and unused points not previously cleared in OsiriX. One tool that was used for this was the Select Lasso. CTRL+SHIFT+ALT hid any geometry within the dragged out selection. This geometry was then deleted using Tool > Geometry > Modify Topology > Delete Hidden. If any holes were created in the mesh during the deletion of polygons, the Close hole button was used to fill them (Tool > Geometry > Modify Topology > Close holes). This process was repeated until all excess geometry was removed.

ZRemesher was used to improve the surface quality of the 3D mesh by retopologizing the mesh and optimizing the pattern of polygons on the model (Tool > ZRemesher) (Fig. 8). The overall polygon count was adjusted by utilizing the Target Polygon Count slider. The polygon count and mesh quality of each model was adjusted multiple times throughout their creation and modification.

Areas of the models with missing data were reconstructed using the Insert Sphere tool (Brush > Insert Sphere). When used, a mask was placed on all geometry except the most recently inserted sphere. Pressing Ctrl while dragging outside of the tool cleared the mask. Tool > Geometry > DynaMesh was then used to merge the new geometry with the original model. Adjustments in the resolution of the resulting mesh were made either with the Resolution slider under DynaMesh or
Figure 8. Retopologizing with ZRemesher. (A) Native pelvic CT data and (B) ZRemeshed pelvic CT data.
by selecting **Geometry > Divide**. This could also have been accomplished with the ZRemesher function.

Several brush tools were employed to manipulate and sculpt the models including Standard, Pinch, Move, Smooth, Inflat, Polish, Clay, and ClayBuildup. The optimized and sculpted adult sacrum subtool was scaled down and aligned with the pediatric sacrum subtool by utilizing the Move, Scale, and Rotate transpose tools (**Transform > Move/Scale/Rotate**) (Fig. 9). The floor grid and reference illustrations were also utilized to line up the correct sizes of each asset.

**Internal Vertebral Venous Plexus**

The internal vertebral venous plexus (IVVP) was created *de novo*, without an available DICOM dataset, using C4D. The sacrum model was exported as an

![Figure 9. Aligned models. Adult model resized and aligned to fit pediatric CT data model.](image)
OBJ from ZBrush (Tool > Export). This model was then imported to C4D (File > Open) retaining its native relative size. In the orthogonal front view, the venous plexus guide illustration was loaded and resized to match the imported sacrum model (Option > Configure > Back > Load). The sketch was used as a guide to draw the splines (Create > Spline > Bezier) for the IVVP including all branches and connecting veins (Fig. 10A). Utilizing the perspective, front, left, and right views allowed the splines to be lined up with the dural space and sacral foramen of the sacrum model.

Each spline was paired with a Circle (Create > Spline > Circle) and placed under a Sweep parent (Create > Generators > Sweep) in the Object panel (Fig. 10B). Depending on whether the spline was representing a main lateral vein, branching vein, or bridging vein it had two, one, or zero fillet caps enabled under the object Attributes > Caps. Each sweep was then transformed into a polygon object by using the Object > Current State to Object function. This generated multiple child objects that were then connected to create a single object (Object > Connect Objects + Delete).

The main lateral veins were grouped into a null object (ALT+G), and the branching and bridging veins were grouped into a separate null object. The two nulls were then placed under a Boole function (Create > Modeling > Boole). Under Boole Attributes, A union B boole type, Create Single Object, and High Quality were checked. The boole was then converted into its current state, and all resulting child objects were connected, creating one single polygon object. For successful import into ZBrush, the new object was optimized (Mesh > Commands > Optimize) in C4D before being exported (File > Export > Wavefront .obj).

The posterior venous plexus was created first then duplicated and adjusted to become the anterior venous plexus. The anterior and posterior plexuses were then connected laterally with more splines to create the entire plexus.
Figure 10. Generating IVVP with splines. (A) Reference illustration loaded into C4D. (B) Bezier and circle splines placed under a Sweep parent to generate the veins of the IVVP.
Dural Sac

The imported dural sac OBJ from OsiriX (Fig. 11) did not include any of the sacral or coccygeal nerve pairs as they branched off of the spinal cord. The OBJ was remeshed in ZBrush, exported, and imported into C4D. In C4D, splines and Sweeps Objects were utilized in the same way that the IVVP was made to create the branching sacral and coccygeal nerve pairs. The sacrum and IVVP were used to guide the placement of the nerve pairs as they run through the sacral foramina. Once completed, the dural sac was reimported into ZBrush where the Inflat Tool was used to create the enlargements of the dorsal root ganglion.

Sacrococcygeal Ligament

The sacrococcygeal ligament was created in C4D by using Cloth and Cloth Collider tags. The sacrum model was rotated horizontally and a plane, with the overall size and shape of the ligament, was placed above it. A cloth tag was placed on the plane (Tag > Simulation Tags > Cloth). The plane was then made a child of a Cloth Surface (Simulate > Cloth > Cloth Surface) and placed into a subdivision surface generator (Create > Generators > Subdivision Surface). A cloth collider tag (Tag > Simulation Tags > Cloth Collider) was placed on the sacrum. The bounce and friction settings were set to 0% and 100% respectively in both the cloth and cloth collider tags. Play was then pressed to activate the gravity of the scene and paused when the cloth surface plane was resting naturally on the sacrum, resembling the sacrococcygeal ligament (Fig. 12). The plane was then converted into its current state and exported as an OBJ.

Preparation for Real-time Environment

All of the separate assets were reassembled in ZBrush and each model was duplicated to create both a high and low polygon version of the model. For models to be imported into Unity3D, the total point count for each mesh had to be less than
Figure 11. Dural sac export. The dural sac mesh was generated using an MRI scan in OsiriX. The dural sac was enhanced by adjusting the Max Intensity Projection (top) to create a 3D volume render (bottom).
Figure 12. Sacrococcygeal ligament model. A cloth surface plane before (top) and after (bottom) colliding with sacrum model to create the ligament model.
65,000. The total polygon count of the entire scene, all of the models combined, had to be approximately 150-200,000. To create the low poly/low point count models, the **Decimation Master** plugin was used. This plugin allowed the models to keep their high-resolution detail while decreasing the polygon count significantly. With one model/subtool selected, **Plugin > Decimation Master > Pre-process Current** is selected (Fig. 13). The amount of polygon reduction is selected using the % of Decimation slider, and **Decimate Current** is selected. This percentage was adjusted until the desired poly and point count were reached. This was repeated for each of the duplicated subtools. The high poly count versions were created using the originally ZRemeshered models. These had significantly higher polycounts and normalized meshes.

**Creating Textures in Cinema4D**

The high polygon models were imported into C4D where texture maps were created for each. With C4D in the **BP 3D Paint** layout, **Paint Set-Up Wizard** was opened, and the object to be mapped was selected. **Next** was clicked on the following two screens, and the default settings were kept. On the third screen, the base color was chosen, a bump channel was activated, and the width and height minimum and maximum were set to 2048 x 2048 pixels. **Finish** was clicked and the final window closed.

With the new texture map selected, a new layer was added and a color and brush were chosen. Similar to painting in Adobe Photoshop, multiple layers, brushes, and colors were used together to create the model’s texture. **Projection Painting** was enabled and used to paint across texture map seams. Some textures required more detailed painting and higher resolution, for this reason, the texture files were saved as (**File > Save Texture As**) TIFF/PSD Layers. The texture file was opened in Adobe Photoshop to allow for more precise painting and resized to allow for a higher
Figure 13. Polycount reduction with Decimation Master. The low polygon decimated mesh (bottom) retains detail from the high polygon mesh (top). Percentage of decimation can be adjusted using the Resolution slider in the menu. *Text not intended to be read.*
Animations were created in C4D to be imported into Unity3D and Adobe After Effects. An animation of the CEB procedure being performed was made using the models created in C4D and ZBrush (skin, pelvis, sacrum, IVVP, dural sac, and sacrococcygeal ligament).

Each model was merged into a single C4D scene and grouped into a null object renamed, Model. (The combined skin, pelvis, sacrum, IVVP, dural sac, and sacrococcygeal ligament will, from here out, be referred to as “the model”.) A main camera was placed in the scene, and a group of lights were set up around the model. The main camera was placed directly posterior to the model. The camera was zoomed out a significant distance and the focal length increased until the model was almost full screen. This adjustment corrected for lens-related perspective distortion that occurred due to the camera’s close proximity to the model. Under **Render > Edit Render Settings**, the Output width and height were changed to 1024 x 768 pixels, the same ratio as an iPad 2, and the file was saved to a new folder on the computer. Any scene rendered was then saved automatically to this location.

A 10 ml syringe with a 22 G needle was created in C4D and sized correctly to match the scale of the model. Beginning the CEB procedure, the model was rotated -90 degrees (to the left), placing it in the initial left lateral decubitus anatomical position (Fig. 14). The model stays in this position for the duration of the injection animation.

The axis point for movement and rotation of the syringe model was moved to the very tip of the syringe needle. Animation of the sequence began with the syringe needle in the epidural space making sure there were no other structures intersecting it. The syringe was keyframed here first, midline at a 45-degree angle from the skin,
Figure 14. CEB procedure animation. The CEB model was adjusted in Cinema4D to begin animation of the procedure.
as the procedure indicates. To place the syringe at the start of the injection sequence, the timeline bar was moved backwards and the syringe pulled directly backwards, just outside of the model. These coordinates were keyframed.

The timeline marker was moved forward, slightly past the position of the syringe in the epidural space. The syringe was rotated from the 45-degree angle to about a 20-degree angle, more in line with the skin, then advanced slightly forward into the epidural space. From here, the plunger was animated and keyframed to reflect the injection sequence (aspirate, test dose, full injection). Finally, the syringe was pulled directly backwards out of the model and keyframed out of the camera view.

This animation was created for use in the Unity 3D application and the prototype animatic for acquiring clinical consultant feedback. Two additional animations were created in C4D for use in the prototype animatic: (1) a “user interaction” animation, to simulate a user interacting with the 3D models as if they were on the iPad screen and (2) an “AR” animation to simulate the movement of the AR marker in a video recording around the stationary model (without the skin or pelvis).

**Creation of Prototype Animatic in Adobe After Effects**

A demonstration of the application was created in C4D and Adobe After Effects (AE) in order to gain feedback from the physicians on the 3D model, injection sequence, and basic user interface of the application. This animation was made to simulate one possible user experience within the application, demonstrating its major functions.

The injection animation created in C4D was rendered out in a series of several PNG sequences: (1) the pelvis, sacrum, dural sac, and IVVP, (2) the sacrococcygeal ligament, (3) the skin, (4) the syringe, (5) the shadow cast on the skin from the
syringe. This allowed for maximum manipulation of the animation in AE. The “user interaction” animation was rendered out as a single PNG sequence. Each of these animations was imported into AE as a PNG sequence with the exception of the shadow layer, which was rendered out as a series of PSD files.

The basic user interface (UI) elements, the title screen, main menu, and the interactive buttons were taken from the original storyboards in Adobe Illustrator, edited and imported into AE. The top iPad bar with wifi, time, and battery percentage was created in Illustrator and imported in AE. This particular AI file was kept at the top of the main composition and was visible at all times. Other graphic elements and text were created in AE to accompany the injection sequence.

Lastly, the AR function of the application was created in AE by combining a video recording of the AR marker, and the “AR” animation of the sacrum (with dural sac, IVVP, and sacrococcygeal ligament). The animation was rendered out of C4D as two PNG sequences, one of the sacrum, another of the sacrum’s shadow. These were imported and compiled in AE.

Five main composition scenes were made: (1) Title Screen, (2) 3D Model, (3) Posterior View Injection, (4) Sagittal View Injection, and (5) AR Model. Each of these compositions was placed into a single composition where any text or graphic elements that were not added to their individual compositions were added. A new composition was then created to house the previous composition and time-remapping was applied (left click > time > time remapping) to slow down the entire animation.

Clinical Consultant Feedback

The demonstration animation was shown to a group of pediatric anesthesiologists including two attending, two resident, and two fellow pediatric anesthesiologists. A second series of questions (Appendix B) was utilized to
guide these conversations. They were able to comment and give feedback on the content and accuracy of the procedure. This feedback influenced the final prototype animation and the content of the application in Unity.

**Creating Interactive Application and AR in Unity3D**

A Unity3D file and code sequence developed by iSO-FORM, LLC, a medical illustration media company based in Ames, IA, were used as a template for creating the CEB Unity3D file. This template included the Vuforia plugin and AR camera, a normal camera, a basic GUI panel with toggle buttons and related coding for labels, transparency, and AR mode, and the code for rotate, pan, and zoom touch settings.

The low poly models, created and exported previously in ZBrush, were imported into C4D. Each model was assigned a basic material with corresponding didactic color. Each of the models was then saved as a single FBX file (File > Export > FBX). For the still models, the Animation boxes (Fig. 15) were unchecked along with Lights, Cameras, and Splines. This was repeated for each model element.

In the Unity Project panel, a new folder was created (CTRL+ Click, Create > Folder). The folder was renamed CEB. Each model element’s FBX file was then imported into the CEB folder (CTRL+click, Import New Asset). A new folder called “Materials” was automatically generated and contained each material file.

Under the previously created list of elements in the Hierarchy panel, the Model folder was opened (Normal view > Model). Within this folder, a new game object was created (CTRL+click, Create Empty). The game object was renamed “CEB Model”, and each of the model elements were dragged and dropped from the Project panel into this folder. Each model element then appeared in the Scene panel. Already existing within the scene is an AR Marker. With the CEB Model folder selected, its Scale, Position, and Rotation were modified in the Inspector panel until it was positioned above the AR Marker (Fig. 16). This position represented how the model
Figure 15. Cinema4D FBX export settings. Default settings. Animation boxes, lights, cameras, and splines were unchecked.

Figure 16. CEB model in Unity scene. The CEB models placed in the Hierarchy panel are positioned above the AR marker (orange) using the transform settings.
would appear in relation to a printed version of the marker through the AR camera.

The code was then edited in Unity3D’s built-in script editor, MonoDevelop, to allow the sacrum to be toggled between “transparent” and “normal” material modes. In the Hierarchy panel, a UI toggle object was created (CTRL+Click, UI > Toggle). The UI toggle element was positioned in the Scene panel using the 2D view option.

The script was opened and the newly imported sacrum model was defined in the existing script along with a true/false bool operation. The bool operation was defined later in the script by telling the sacrum model to be either the true, “transparent”, or false, “normal”, material depending on the state of the UI toggle, “on” or “off”, respectively.

A game object, Camera target, was previously created in the Inspector panel to house the main script. All of the objects defined in the script were found here and assigned their corresponding models, game objects, or materials. The sacrum model in the inspector was dragged into the newly created Sacrum game object field, and

Figure 17. Script objects defined. Models and materials dragged into object fields created in the master script.
the normal (sacrum) and transparent materials from the Project panel were dragged into their corresponding Normal mat and Transp mat fields (Fig. 17).

The toggle object was selected in the hierarchy window to show its settings in the Inspector panel. Under the Toggle (Script) tab and in the On Value Changed (Boolean) section, the + symbol was clicked, and the Camera object in the Hierarchy menu was dragged into the blank field to load the main script options. The No Function drop down menu was clicked, and the newly defined bool operation from the script was assigned to the toggle (Fig. 18). The Play button was then clicked to check the function of the toggle button.

![Figure 18. Bool operation assigned.](image)

3D Print

A 3D print of the sacrum was created by modifying the 3D sacrum model to printing standards, uploading the file to Shapeways.com, an online 3D printing marketplace, and ordering the 3D print.

In ZBrush, the sacrum was made hollow and given a “shell.” First, the sacrum subtool was made visible and duplicated. All other subtools were hidden. In order to access the Create Shell function, the model must be in DynaMesh mode (Tool > Geometry > DynaMesh). The resolution of the resulting mesh was adjusted using the Resolution slider. A hole within the model must then be created. Under the Brush palette, Insert Cylinder was chosen. While holding the ALT key, the cylinder was dragged into the scene and its size and placement adjusted using the Scale, Move, and Rotate transpose tools. The cylinder was positioned to intersect with the mesh.
and placed deep enough within the mesh for an appropriate shell thickness to be created. A mask was automatically placed on the sacrum when the cylinder was inserted. This was cleared by holding CTRL + dragging on the canvas. The thickness of the shell was adjusted using the Thickness slider, and the Create Shell button was clicked (Tool > Geometry > DynaMesh > Create Shell). The inserted cylinder disappeared and a thickness was added to the mesh of the entire object (Fig. 19).

The file was exported from ZBrush as an OBJ and uploaded to the Shapeways.com where it was checked for 3D printing compatibility and sent for off-site printing.

Figure 19. 3D print, create shell. Thickness given to sacrum model using DynaMesh Create Shell function (inset).
Results

Educational Content Goals

Through research and conversations with clinical consultants, the following content creation objectives were defined in order to guide the development and prioritization of topics within the application and overall project.

1. Convey the three-dimensional relationships of the CEB anatomy and surface landmarks.
2. Communicate the major steps of the procedure: set up, localization of the caudal space, needle placement and trajectory, and injection.
3. Explain tactile feedback through visual examples, including the use of a common procedure demonstration technique employing the knuckles of the observer and 3D prints of anatomical models.
4. Provide information regarding procedure indications, appropriate dosing, and what to do in the event of complications.

Review of Literature

A table of relevant measurements (Table 1) was compiled from a review of the literature including the location of the termination of the dural sac and conus medullaris, anterior-posterior canal depth at the sacral hiatus, distance from the dural sac to the sacral hiatus, and the distance between sacral cornua or the width of sacral hiatus. These measurements were used to inform the creation of the reference illustrations and the 3D models using DICOM dataset exports as a guide for the appropriate shape and proportions.
<table>
<thead>
<tr>
<th>Anatomy</th>
<th>Pediatric</th>
<th>Adult</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anterior-posterior canal depth at sacral hiatus (mm)</td>
<td>2.8 (Shin et al. 2009) 3 (Lees et al. 2014) 3.9 ±1.3 (Lees et al. 2014) 4.8 (Adewale and Dearlove 2000)</td>
<td>4.46 ±1.3 (Lees et al. 2014) 6.0 (Senoglu et al. 2005)</td>
</tr>
<tr>
<td>Distance from dural sac to sacral hiatus (mm)</td>
<td>3-13 (Lees et al. 2014) 12-57 (Lees et al. 2014) 30.1 (Adewale and Dearlove 2000)</td>
<td>35.4 (Senoglu et al. 2005)</td>
</tr>
<tr>
<td>Distance between sacral cornua/width of sacral hiatus (mm)</td>
<td>5-10 (NYSORA 2008) 5-10 (Suresh and Wheeler 2002) 9 ± 3 (Lees et al. 2014)</td>
<td>10.2 (Senoglu et al. 2005) 17 ± 3 (Lees et al. 2014)</td>
</tr>
</tbody>
</table>

| Table 1. Pediatric versus adult comparative sacral anatomy. Measurements compiled from the review of academic literature. |

**Flowchart and Storyboards**

A flowchart (Fig. 20) was created to organize the content of the application into major topics and assign the media type for each of the subtopics. Media types included illustration, photography, video, animation, 3D models, and AR (augmented reality). Storyboards (Fig. 21.1-12) were created from selected user-interaction pathways within the flowchart. Numbers on the flowchart content boxes correspond to the numbers on the storyboards. Selected sections included the following pages: (1) Splash/Title, (2) Accessing the Caudal Space, (3) Adult vs. Pediatric Sacrum, (4) Ultrasound/Diagram Slider, (5-6) Knuckle Demonstration, (7) Animation, (8) Animation: Sagittal Section, (9) Interactive 3D Model, (10) Needle, (11) Sagittal Section, (12) View AR Model.
Figure 20. Flowchart. Content of application organized in flowchart. Numbered boxes correspond with storyboard panels.
Figure 21.1-2. Storyboards. Application storyboards.
Figure 21.3-4. Storyboards. Application storyboards.
Figure 21.5-6. Storyboards. Application storyboards.
Figure 21.7-8. Storyboards. Application storyboards.
Figure 21.9-10. Storyboards. Application storyboards.
Figure 21.11-12. Storyboards. Application storyboards.
**Three-Dimensional Model**

A 3D model of a pediatric sacrum, pelvis, dural sac, internal vertebral venous plexus, and sacrococcygeal ligament were created in ZBrush and Cinema4D using data integrated from CT and MRI datasets. A series of reference illustrations (Fig. 22.1-2) were created to synthesize the data in Table 1 and used in model creation.

Using the 3D models, a series of 2D images were created to exhibit the anatomical details of the entire model (Fig. 23-31). These individual renders can be utilized separately from the animation or application. Additional still images were created to compare the adult and pediatric sacrum in the prototype animatic (Fig. 2-3).
Figure 22.1. Reference illustrations. Illustrations created of the posterior sacrum and coccyx from Table 1 and CT and MRI datasets. (A) CT data (B) fused laminae cut (C) sacrum with IVVP and dural sac.
Figure 22.2. Reference illustrations. Illustrations created of the sagittal sacrum and coccyx from Table 1 and CT and MRI datasets. (A) CT data (B) sagittal section (C) sagittal section with dural sac.
Figure 23. Full model, posterior. Pelvis, sacrum, sacrococcygeal ligament, dural sac, and internal vertebral venous plexus (IVVP).
Figure 24. Full model, anterior. Pelvis, sacrum, sacrococcygeal ligament, dural sac, and IVVP.
Figure 25. Sacrum model. (A) posterior (B) anterior: sacrum, sacrococcygeal ligament, dural sac, and IVVP.
Figure 26. Lateral models. (A) with pelvis (B) without pelvis: sacrococcygeal ligament, dural sac, and IVVP.
Figure 27. Dural sac and IVVP. (A) posterior (B) lateral (C) anterior.
Figure 28. IVVP. (A) posterior (B) lateral (C) anterior.
Figure 29. Dural sac. (A) posterior (B) lateral (C) anterior.
Figure 30. Sagittal sacrum model. Sacrum, sacrococcygeal ligament, dural sac, IVVP.
Figure 31. Skin model. (A) posterior, with transparency: pelvis, sacrum (B) lateral decubitus patient positioning for procedure.
**Didactic Procedural Animations**

The animations demonstrated the CEB procedure from both the physician’s position, posterior to the child, and from a sagittal, cross-sectional view. Both animations show the following steps: (1) syringe inserted into the epidural space through the skin and sacrococcygeal ligament at a 45 degree angle to the skin, (2) dropping the angle of the syringe inferiorly to a more acute angle in relation to the spinal canal, (3) advancing the needle forward, (4) aspirating the needle, (5) injecting the anesthetic, and (6) extracting the needle to complete the procedure. Both of these sequences, when shown to the physicians, generated a lot of usable feedback. These animations were integrated into the 3D interactive environment of the final interactive application. The user may press the “Play Injection” icon and watch the animations from any angle in the interactive environment.

**Prototype Animatic**

A prototype animatic (Fig. 32-45) was created to simulate a user interacting with the 3D models through the iPad interface. This animation exhibits the zoom, pan, and rotate-touch functions. It also demonstrates the “toggle visibility” function of the application by changing the transparency of the separate 3D assets as well as the didactic procedural animations. The application UI, as designed in the storyboards, was implemented and updated for display in the prototype. Additional vector elements were created to overlay on the animations including arrows, labels, and landmarks along with touch indicators (showing viewers where and when the iPad application would have been touched to elicit the observed animatic). An AR prototype animatic of the model (sacrum, IVVP, dural sac, and sacrococcygeal ligament) was also created to simulate a video recording around the stationary AR 3D model.

The prototype animatic was used to simulate the interactive environment and
demonstrate the AR mode through the iPad camera. This prototype was integral in obtaining clinical consultant feedback, which was employed to finalize the interactive content, and show users what capabilities the final Unity application would have.

**Interactive Application**

Selected components of the full Unity-based interactive application were completed, including integration of the 3D models of the skin, sacrum, pelvis, IVVP, dural sac, and sacrococcygeal ligament. The application allows users to interact with the model on the iPad screen through zoom, pan, and rotate touch functions. The user can toggle the transparency of the sacrum and view the model through the AR camera (Fig. 46).

**Sketchfab Model Viewer**

The full sacrum model was published to a 3D model-sharing website, Sketchfab.com, where any user can view the model (Fig. 47). The model interaction on Sketchfab is similar to the Unity application with zoom, pan, and rotate capabilities through touch or mouse input. Labels were added to the model, which can be turned on or off. Sketchfab allows the model to be embedded in websites or shared through a link.

**3D Print**

A 3D print of the sacrum was created through Shapeways.com to allow for a hands-on comparison of the adult and pediatric sacrum (Fig. 48).
Figure 32. Splash page. Corresponds to box 1 in flowchart and panel 1 of storyboard.

Figure 33. 3D model. Corresponds to box 9 in flowchart and panel 9 of storyboard.
Figure 34. 3D model, zoom. Corresponds to box 9 in flowchart and panel 9 of storyboard.

Figure 35. 3D model, labels. Corresponds to box 9 in flowchart and panel 9 of storyboard.
Figure 36. **Injection landmarks.** Corresponds to box 10 in flowchart and panel 10 of storyboard.

Figure 37. **Injection angle.** Corresponds to box 10 in flowchart and panel 10 of storyboard.
Figure 38. Injection, pop. Corresponds to box 10 in flowchart and panel 10 of storyboard.

Figure 39. Injection, drop angle. Corresponds to box 10 in flowchart and panel 10 of storyboard.
Figure 40. **Injection.** Corresponds to box 10 in flowchart and panel 10 of storyboard.

Figure 41. **Sagittal injection angle.** Corresponds to box 11 in flowchart and panel 11 of storyboard.
Figure 42. Sagittal injection, pop. Corresponds to box 11 in flowchart and panel 11 of storyboard.

Figure 43. Sagittal injection, drop angle. Corresponds to box 11 in flowchart and panel 11 of storyboard.
Figure 44. **Sagittal injection.** Corresponds to box 11 in flowchart and panel 11 of storyboard.

Figure 45. **AR model.** Corresponds to box 12 in flowchart and panel 12 of storyboard.
Figure 46. Unity3D application. AR function enabled through Unity desktop viewer. Transparency toggled off (top) and on (bottom).
Figure 47. Sketchfab model. Model, with labels, as seen through Sketchfab.com embedded viewer.
Figure 48. 3D printed model. Sacrum model printed through Shapeways.com. Comparison of adult sacrum and printed pediatric sacrum (top). Detail of model (bottom).
Access to Assets

The products created from this thesis can be viewed at www.caitlinmock.com or by contacting the author at ejmock@gmail.com. The author may also be contacted through the Department of Art as Applied to Medicine at Johns Hopkins University School of Medicine, http://medicalart.johnshopkins.edu/.
**Discussion**

*Developing a Solution to Reduce the CEB Learning Curve*

The primary goal of this project was to design and develop a novel educational application that aims to reduce the learning curve for performing pediatric caudal epidural nerve blocks through 3D visualization of the sacral anatomy by providing consistent and accurate pre-procedure pediatric epidural block training to physicians. Developing this solution began with a thorough literature review and survey of extant educational material. Available print and online resources often depicted the CEB procedure with a variety of images. Some resources, such as *Miller’s Anesthesia* (Miller et al. 2014), use a cross section of the sacrum to show where the needle should be inserted and at what angle; others, such as NYSORA.com (NYSORA 2008), depict the surface anatomy through clinical photographs. Nearly all of these resources are limited to visualizations of the adult sacrum, which differs substantially from the pediatric sacrum in size, shape, and location of the internal structures (Fig. 1-2). Videos (“Caudal Injection” 2013) of the procedure show the external surface anatomy but do not depict the internal anatomy that corresponds to the surface landmarks. These resources, therefore, fail to establish the spatial relationships necessary to fully comprehend the CEB by not representing both the surface and internal anatomy simultaneously. Additionally, skeletal sacrum bones or replicas that could be used as reference for tactile feedback are nearly always from adult skeletons.

A mobile-based interactive application was chosen as the most appropriate educational media for depicting the trajectory of the needle during the CEB as related to the superficial and internal anatomy. Interactive environments made possible with such applications allow the user to be in control of their learning, setting and meeting their own objectives and maintaining greater interest in their education.
Clinical consultants involved in the development of this application identified numerous electronically available resources that were widely used to review anesthesiology procedures. These include: http://www.usra.ca/, http://www.nysora.com/, PubMed articles, and YouTube videos. Additionally, being able to review procedure techniques at work or home was identified as important to clinical consultants. This reinforced the need for a mobile-based interactive application that was available anytime, anywhere. At the Johns Hopkins Hospital, residents are given an iPad for educational and professional purposes. For this reason, the iPad was chosen as the target device.

**Assigning Media Styles**

After individual and group discussions with clinical consultants, a list of relevant concepts, conclusions, and overall educational goals was compiled. These major educational goals about the procedure and the currently available resources helped to define major topics and subtopics in the flowchart (Fig. 20).

Each subtopic was assigned a type of media to best meet the specific educational goal. Additionally, offering a variety of media types accommodates individualized learning styles (Ruiz, Mintzer, and Leipzig 2006). Media types included illustrations, photos, videos, animations, and 3D and AR models. For example, a photograph was decided to be sufficient to convey the content of the “Procedure Set-up” subtopic. In this case, a photo of a real operating room would be most similar to the user’s environment during the procedure. Conversely, it was determined that an accurate 3D model of the pediatric sacral anatomy would be best suited to clarify the conceptual complexity of the sacrum and epidural injection found in the subtopic “Interactive 3D Model”. An animation was decided to be the best solution to convey the CEB procedure as it allows for an intentionally paced and guided review. The complete scope of multi-media assignments is show in the completed flowchart.
**Addressing Three-Dimensional Relationships and Tactile Feedback**

Performing the procedure successfully requires an understanding of the relationships between surface landmarks and underlying anatomy, the ability to locate the injection site, and to recognize the tactile feedback during the injection sequence. Additionally, one must know the right block for the right procedure, what and how much anesthetic to administer, and what to do if complications such as intrathecal puncture or intravascular or intraosseous injection occur (Suresh and Wheeler 2002).

The 3D relationships of surface landmarks and underlying anatomy were addressed through the creation of an interactive 3D model of the pelvis, sacrum, sacrococcygeal ligament, and distal portion of the dural sac and internal vertebral venous plexus. This model was the cornerstone of the project and was utilized to create the separate 3D interactive learning components of the application.

The most complex aspect of the procedure to convey through an interactive application was the tactile feedback. The ability to perform the procedure relies on identifying and palpating the landmarks and feeling the feedback of the syringe as it “pops” through the sacrococcygeal ligament and into the caudal epidural space. Because these could not be conveyed through interaction with the screen of an iPad, extra measures were taken to point out the landmarks during the injection sequence with cueing elements. Cueing elements, such as arrows, graphic shapes and labels, draw attention to specific learning material in animations or visualization, improving recall and retention of information (de Koning et al. 2009).

The flowchart and storyboards include a section called the “Knuckle Demo”. This is a teaching technique that attempts to correlate the feeling of two knuckles to the paired sacral cornua. The video demonstration is designed to encourage users to try the technique on their own knuckles to reinforce a tactile experience. Another way to convey the tactile feeling of the anatomy was through the creation of a 3D print of the sacral model. Users could correlate the structures seen on screen to the 3D print
in their hands for a more complete learning experience. Educators could also have access to the print to use on-site to teach the anatomy and location of the injection. The 3D print would also serve to reinforce the major size differences between the adult and pediatric sacrum.

Additional pages within the application are proposed in the flowchart and storyboards to address indications for the procedure, how to calculate correct dosages, and what to do in the event of complications. Each of these sections has the potential to be developed as part of the full application.

**Anatomical Reference Material**

The available references on pediatric anatomy were extremely limited. The models created relied heavily on adult anatomical references, a small number of pediatric resources, and CT and MRI datasets. Additionally, determining the age of the anatomy depicted in any illustration, image, or diagram was difficult as most were only labeled with “pediatric” or “child” and not an exact age. In the end, a full pediatric model was created through a combination of pediatric and adult CT and MRI references and measurements from the literature.

It was decided that three-months old would be the target age for the model because it is a typical age for pediatric patients undergoing surgeries of the lower half of the body who are not yet able to ambulate. CT scans of children this age are often not performed due to the radiation risks associated with the procedure (Brenner et al. 2001). MRI scans are slightly more common, but were still difficult to obtain. This limited the 3D references available to create the model, which ultimately consisted of one pediatric pelvic CT scan and two pediatric pelvic MRI scans. Literature references and radiological references were combined to create averaged reference images for 3D modeling (**Fig. 22.1-2**).

CT data, in particular, was integral in laying the framework for the overall
dimensions of the sacrum and pelvis. The MRI datasets provided the basic shape and dimensions of the dural sac. Using real data allowed for the creation of a novel, accurate and to scale 3D visualization.

**Modeling**

The raw OBJ exports from the radiological datasets were not uniform in texture or symmetry and were missing numerous sections of data. While it is realistic for boney anatomy to be asymmetrical, this type of information is not relevant to teaching the CEB, therefore, a smooth, symmetrical model that eliminated variations in symmetry was utilized for teaching purposes. This was achieved through manually reconstructing the missing data, using the ZRemesher feature in ZBrush, and creating symmetry.

The sacrum and pelvis do not completely ossify until approximately eight years of age (Adewale and Dearlove 2000). The final 3D surface rendering of the pediatric data sets only included the boney centers of ossification and not the cartilaginous framework because the cartilage did not vary enough in density from surrounding tissues to isolate it successfully. While an incomplete model, this provided a basic architecture for the full sacral and pelvic models to be built upon.

The tactile quality of both bone and cartilage are the same when palpating the “boney” landmarks during the procedure. Therefore, differentiating between the bone and cartilage portions of the 3D sacrum and pelvis models would not have been relevant to teaching the CEB and, in fact, could cause the user to incorrectly expect a difference in tactile experience while performing the CEB in real life. The final model combined the ossified and cartilaginous portions of these bones into one model.

A great deal of trial and error occurred throughout the modeling process. The models were imported and exported multiple times between ZBrush and C4D.
ZBrush worked best for sculpting an organic mesh while C4D was more effective at subtracting flat uniform sections away from the 3D models (Boole Object) and creating sharp edges. Working between the two programs fixed some problems and created others. For example, the dural sac was created efficiently in C4D by combining the MRI-extracted data with Splines. However, when the dural sac object was brought into ZBrush to create the ganglion enlargements on the spinal nerves, the seemingly clean mesh had developed holes, which had to be filled in order to continue modeling. Problems such as these were overcome with mesh-repair tools in ZBrush or with point-by-point manipulation of the surface mesh during creation of the models.

**Prototype Design**

The prototype animation was created to give users the opportunity to experience the application prior to the completion of the interactive Unity project. When creating the layout of the application in After Effects, the graphic elements were designed to be simple, clean, and limited to avoid distracting viewers from the didactic content, therefore, allowing for better comprehension. Following best practices for mobile development, little text was used and navigation was built into each page (Lund, Wight, and Manager 2005). Through discussion with clinical consultants, it was decided that the button functions such as labels, landmarks, quiz, draw, and save would be beneficial to include in the application to aid in learning the anatomy and the injection procedure. It was also decided that the structures were identifiable, and the injection sequence was clear.
**Further Development of Augmented Reality**

Most learning in the medical field occurs at the workplace (Kamphuis et al. 2014). Physicians are expected to perform at a high level, therefore, ample opportunity should be provided for them to practice difficult procedures in an educational setting. The reality is that training opportunities and education materials are not always available due to monetary, time, or safety constraints (Kamphuis et al. 2014). There are deficiencies in medical education when it comes to training situational awareness in environments like the operating room (Barsom, Graafland, and Schijven 2016).

Augmented reality is a possible solution to this problem and has the opportunity to be developed further in future versions of this project. AR allows for realistic training opportunities to occur outside of the operating room, leading to fewer mistakes in the operating room (Barsom, Graafland, and Schijven 2016). Adding a new dimension to traditional educational materials increases the user’s interest in learning, thus improving retention of the material (Küçük, Kapakin, and Göktaş 2016). Overall, the “sense of presence, immediacy and immersion” that AR can give to the learner can be meaningful in their overall learning experience (Kamphuis et al. 2014).

Future investigations are needed to clarify how the AR 3D model could be best customized and used per individual CEB case. Multiple markers could be used to scale the sacrum model to match the specific anatomy of each child. The AR model could then be projected on the child providing a “virtual transparency” of the skin aiding in visualization of the underlying anatomy (Marescaux et al. 2004). To rely on the positioning of the anatomy completely during an injection would require more advancement in augmented reality technology.
Future Application Development

The application could be developed in full as outlined in the flowchart for future versions. Additional items could be added to the existing animations. For example, the injection sequence could incorporate a hand palpating the sacral cornua, steadying the needle, and feeling for subcutaneous injection. This would add valuable educational content to the animated injection sequence. A voiceover could also be added to the injection sequence to supplement the on-screen content. This could benefit auditory learners with a preference for verbal communication of information and enhance the application’s overall effectiveness.

A randomized comparative investigation would be necessary to analyze the efficacy of the application in teaching the procedure. Participants could be given a knowledge assessment then randomized into three groups; experimental group 1 would be given the CEB application, experimental group 2 would be given a standard text-based learning material, and a control group would receive no new material. All groups would then take the knowledge assessment a second time. Final scores would be compared to measure the effect of the CEB application. This comparative data would gauge the impact of the application and provide feedback for improvement.

The software used and the steps performed to create the model for the CEB can be repeated for all other epidural and regional anesthesia procedures for both pediatric and adult models. A complete series could be developed and used in the training of anesthesiologists. This has the potential to make learning these procedures much more effective through the centralization and standardization of the materials and methods.
CONCLUSION

Caudal epidural blockades are one of the most frequently used blockades in pediatric regional anesthesia, but they are associated with a steep learning curve. This project addressed the lack of pediatric anatomical visuals in teaching CEBs by providing a novel, data-driven interactive 3D model of the “caudal” anatomy and an animation that depicts both the surface and underlying anatomy simultaneously.

Expected benefits of depicting the CEB in a real-time interactive environment for the first time include increasing understanding of the sacral anatomy and reducing the learning curve associated with the CEB procedure. By distributing the model and animation online, users can access it for training and review at any time and location.

The novel integration of real-time 3D and augmented reality in teaching pediatric sacral morphology fills a gap in educational resources available for CEBs. This project lays the foundation for the complete development of the CEB application and a possible series of applications in pediatric regional anesthesia. Infusing these new technologies into medical education opens the door for future innovations in biomedical communication.
Appendix A

Physician Consultant Questions, Pre-Production

Your first time performing a caudal block (pediatric)

1. What was the most difficult aspect?
2. What was unexpected?
3. What did you think would be easier/harder?
4. What became easier with time?
5. What has taken the longest to master?
6. What methods do you use to locate the caudal space? Any particular anatomical landmarks?

How did you prepare before performing the procedure for the first time?

7. What resources (not people) did you have access to?
8. What resources did you use the most?
9. Were there resources that were not useful? Not good to find out technique? Why?
10. Were there any resources you looked for but were unable to find?
11. What visual resources/assets did you use? How useful were these?

What types of visual aids would be useful for teaching/understanding caudal epidural blockades? (illustrations, photographs, animations)

12. What types of visuals are most useful to your learning?
13. If you had to pick one aspect of the procedure to supplement with additional learning tools, which would you choose?
14. Would an animation depicting the movement of the needle in relation to the underlying anatomy be helpful for someone learning to perform a caudal block?
15. Would any aspect of the procedure be useful to see animated for someone about to perform her or his first caudal block?

How would you explain the technical aspects of performing a caudal block to a physician who had never performed it or seen it performed?

16. Would you use (existing) images to explain the procedure?
17. Would you make a drawing to explain the procedure?

Additional Questions

18. What needle do you use to perform the block?
19. Is there a specific way in which you insert the needle?
20. What indicates to you to stop pushing the needle forward?
21. Have you ever used anything to assist your visualization of the space (ultrasound)?
22. Have you ever held/examined an adult sacrum (skeletal or model)?
23. Have you ever held/examined an pediatric sacrum (skeletal or model)?
24. Do you/have you ever use any resources to review before or during procedures?
25. Are you more likely to review from a book or an electronic resource?
26. Would you use an app to review regional block information including anatomy, technique, indications, and dosing?
APPENDIX B

Physician Consultant Questions, In-Production

Medical content- models/Procedure

1. Can you understand what the dark blue structure is?
2. What the pink structure is?
3. What the light blue structure is?
4. Are you surprised by the scale of the sacrum or sacral hiatus?
5. Are the models different than you expected and why?
6. Is it helpful to have control of the opacity of the individual models?
7. Is it helpful to see the pelvis when viewing the injection?
8. Would you anticipate using the quiz section?
9. Would you anticipate using the draw section?
10. Would you anticipate using the save section?
11. Is the point of view/camera angle confusing?
12. Would you like to see it from other viewpoints, if so what point of view?
13. Do you disagree with any of the anatomy shown? If so, what?
14. Do you disagree with the injection sequence? If so, what?
15. Can you interpret the function of each of the buttons?
16. Had you used augmented reality in an app before this?
CITED REFERENCES


**General References**


Vita

Caitlin Mock was born on November 24th, 1991 in Kansas City, Missouri. She grew up in the small town of Pella, Iowa where her love of learning was nurtured by outstanding teachers and mentors.

Caitlin attended Iowa State University (ISU) in Ames, Iowa, and graduated magna cum laude in 2014 with a Bachelor of Arts in Biological and Pre-Medical Illustration (BPMI) and a minor in Spanish. While studying at ISU, she found success in the BPMI program, earning numerous awards for her artwork and academic achievements.

In August 2014, she continued her education in the Medical and Biological Illustration program in the Department of Art as Applied to Medicine at the Johns Hopkins University School of Medicine. While studying for her graduate degree, Caitlin received an Award of Merit from the Association of Medical Illustrators and was named a Vesalian Scholar for her thesis work. In the future, she hopes to use new technologies to find novel and exciting ways to teach medical and scientific subject matter. Caitlin will be receiving her Master of Arts degree in May of 2016.